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Outline: ISA Tools for WebSphere on z/0S

Garbage Collection analysis:

— GC and Memory Visualizer (GCMV) **

— Pattern Modeling Tool for Java GC (PMAT)
Dump analysis:

— Memory Analyzer (MAT) **

— Dump Analyzer **

— HeapAnalyzer

— Memory Dump Diagnostic for Java (MDD4J)

— Thread & Monitor Dump Analyzer for Java (TMDA)
Trace analysis:

— Trace and Request Analyzer for WAS

— Log Analyzer
Real-time analysis: Health Center **

Configuration analysis: Visual Configuration Explorer (VCE)

-

-
SHARE

** “IBM Monitoring and Diagnostic Tools for Java™”

Appendix
— Installing the IBM Support Assistant

— Other Diagnostic Tools for WebSphere on z/OS
— Working with Dumps & Traces

— Testing Tools & Sample Applications

— Documentation, Help & Web Resources
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Diagnostic Data from WAS on z/OS
TSO/SDSF
Browse logs
yxftt"a‘::?r']g gg‘ds &0 [T How many ways can we
S (L
Display WAS Servi  F1I e analyze WAS on z/0S?
Other TSO/ISPF Apps Workstation z/I0S
RMF Monitors 3270/TS0O Comm Server
IPCS - SDSF/MVS T —— >{ + TN32T0
Teinet Glent e | J e Artitacts
View logs Telnet telngt m——————— »>{ + INETD D
Lelnet e —— —telnet. i SMF
UNIX commands e Y L=
FTP . \Wsadmin I J-—ﬁ—p —————— >« FTP Server € > data
Javatools Browser | e
Jextract, . . . .« ISC (TPV) e ——__fitp_ === > WAS R > -
Web Browsers = * Server e
ISC - TPV + Analyzers  w _EM||_;Pg ;
z/OSMF Inc.Log M . VCE : port e I
ISA Tools + Health Center . "““1@7?‘ Servant Region JVM
e Health Center : p
e GC analyzers WAS/OEM
+ Dump analyzer: | — « ZOSMF
* Log Analyzers ) S
« VCE umps o ' Dumps
races P Traces
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Which Tools for which Artifacts?

Artifact Tool
GCverbose xml (SYSOUT) GCMV
PMAT
Javacore TMDA
Heapdump Memory Analyzer
MDDA4J
HeapAnalyzer
System Dump (jextracted) Memory Analyzer
Dump Analyzer
Logs & Traces TRA
Log Analyzer
Real Time Running Server Health Center
Configuration XML files VCE
7/27/2010 4

SHARE 115 - Boston

© 2010 IBM Corporation




—

£
IBM Support Assistant (ISA) - Launch pad: s«a=«

Support Assistant

%2 Collect and Send Data
% Find Inforrmation

& Home IBM Support Assistant

B & Problem Tools Catalog Fithd new add-c

Tool Mame | ‘Yersion |
%@ [Tech Preview] Database Connection Pocl Analyzer for IBM WebSphere Application Server 1.5.0.02

[Tech Freview] HeapAnalyzer 4.0.6.00

[Tech Preview] IBM Pattern Modeling and Analysis Tool for Java Garbage Collector (PMAT) 4.0,1.00

[Tech Preview] [BM Port Scanning Tool 1,1.0.00

[Tech Preview] IBM Thread and Monitor Dump Analyzer for Java (TMDA) 4.0.1.00

[Tech Preview] IBM Trace and Request Analyzer for WebSphere Application Server 2.5.0.00

[Tech Preview] IBM Web Server Plug-in Analyzer for WebSphere Application Server (WSPAY  3.5.0.02

[Tech Freview] Memory Dump Diagnostc for Java (MDD4J) version 3.0 3.0.1.beta-20091201202124

[Tech Preview] ThreadAnalyzer (Ceprecatad) £.0,3.02

[Tech Preview] Yisual Configuration Explorer 10,16, 201006151648

IBM Monitoring and Diagnostc Tools for Java™ - Dump Analyzer 2.2.2,20090926232659

IBM Monitoring and Diagnostc Tools for Java™ - Garbage Colection and Memory Yisuaizer  2.4.0.20100127

IBM Maonitoring and Diagnostc Taools for Java™ - Health Center 1.2,1.20100721

IBM Monitoring and Diagnostc Tools for Java™ - Memary Analyzer [Tech Preview] 0.6.0.2010070&1358

Log Analyzer 4.5.0,2003092409 16

Memaory Dump Diagnostic for Java (MDD41) 2.0.0,20081219132011

Launch Submit Feedback Help

getermination, or use the a More News... 5
Service Request function to

o

GC Visualization and Analysis

<af type="tenured" id="13" timestamp="Jul 30 17:33:20 2009" intervalms="1.601">
<minimum requested_bytes="24" />
<time exclusiveaccessms="0.132" meanexclusiveaccessms='"0.063" threads="4" lastthreadtid="0x43FA
<refs soft="249" weak="11193" phantom="2" dynamicSoftReferenceThreshold="0" maxSoftReferenceThr
<tenured freebytes="0" totalbytes="536870400" percent="0" >
<soa freebytes="0" totalbytes="536870400" percent="0" />

</tenured>
1. Enable verbose GC in your ISC: ss than 4%)" />
— AppServer -> Process defs -> Servant -> JVM, click on g

“Verbose garbage collection”.

— Click “OK”, Save the changes, and re-start server.
2. Verify the verbose GC setting using SDSF

— Look for <af> & <gc> xml structures in servant’s log.
3. Drive an application in your server.

— Use your own, or sample apps provided. L xSoftReferenceThr:

— Jmeter, MS Web AppStress tool or your own to drive load.
4. Copy verboseGC output from SYSOUT to ASCII file

(on your workstation)

5. Launch GC verbose visualizers (GCMV or PMAT) and
browse to the file you uploaded.

7/27/2010 SHARE 115 - Boston © 2010 IBM Corporation 6




GC Tuning Suggestions i

Do this before putting your applications into Production:

1. Install the application, test it.
2. Set JVM heap min/max size, & enable Verbose GC

3. Use aload driver to drive a representative, but constant load.
(Consider using a “peak” load.)

4. Extract verbose GC statistics and study with a visualizer.
5

Under peak load, the time between GCs should be:
. Constant, and about once every 10 seconds or more.

6. Look for Memory leaks — times between GC shorten.

7. Tune by experimenting independently with different heap sizes
and GC policies.

8. To study the JVM contents, take a heap, core, or SDump, and
use one of the Dump analysis tools.

(Don’t forget to also analyze your applications with a profiler such as
JinsightLive for System z.)

712712010 SHARE 115 - Boston © 2010 IBM Corporation

s

=

GC Visualization and Analysis tools  s#»=«

Launch one of the GC verbose visualizers (GCMV or PMAT) and
browse to the file you uploaded.

Rl <, Analyze Problem x
& B Bl e b Rl a el &1 Tool Input Parametel x| =0

Case/Incident
1BM Monitoring and Diagnostic Tools for Java™ - Garba olection and Memary Visualizer
Idefault /
Log name Browise. ., /

Tools Catalog

Tool Name Eﬂ_svstem File Browser = x|
[Tech Preview] Database Connect Case Manager Browse Remote Artifact Browse |

[Tech Preview] HeapAnalyzer 3.9.8.00 -
[= My CompLiter ; -

[Tech Preview] IBM Pattern Modeling and Analysis Tool for Java Garbage Cr 3.9.0.01 o ,;{?Local Agent j
[Tech Preview] IBM Port Scanning Tool 1.1.0.00 B3 Windows
[Tech Preview] IBM Thread and Monitor Dump Anakyzer for Java (TMDA)  3.9.0.00 ERERen)
[Tech Preview] IBM Trace and Request Analyzer for webSphere Applicatior 2.1.0.03 B3 1162ac4607b24 2864385
[Tech Preview] IBM Web Server Flug-in Analyzer for WebSphere Applicatior 3.5.0.02 - [3 B7elaccS66al54a3d7be0asdi 14 180ba
[Tech Preview] Memory Dump Diagnostc for Java (MDD43) version 3.0 3.0.Lbeta-2 B3 adsm.sys
[Tech Preview] Threadanalyzer (Deprecated) 6.0.3.02 B3 AppTraces
IBM Monitoring and Diagnostic Toals for Java™ - Dump Anabyzer 2.2.2.2009( B addhodelog
IBM Moritoring and Diagnostic Tools for Java™ - Garbage Collection and Me 2.3,0.2009( B Colector_2009-07-27-14-59-44.2p
IBM Monitoring and Diagnostic Tools for Java™ - Health Center 1.1.0.2009: S 32;:3:??;?:;;'09
1BM Monitoring and Ciagnostic Tools for Java™ - Memory Analyzer (Tech P 0.5.2.2009] B Dump%alyzer_WASBaschnfo_Report‘txt
Log Arialyzer 45.0.2003( - DUmpAnalyzerLog_S¥S 1.DUMP, DOS1007,
Memory Dump Diagnostic for Java (MDD4J) 2.0.0.20087 -E) DumpanalyzerLog_svs 1.DUMP DOS 1007,
Symptom Editor 4.5.0.20039( E) Dumpanalyzerfeport_SYS1.DUMP.DOS10

<
wisial Configuration Explorer (Tech Preview) 1.0.16.200¢ L___* E Egjjrkfjfj:fiiz;?:s&uzjgi; FEFILI

‘ Launch | | Submit Feedback ‘ ‘ Help
Cancel
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GC and Memory Visualizer (GCMV) -ivpT1y  s#a=re
Summary
Uses verbose GC (xmldoc) | .. .
ocation failure count 137
Forced collection count 3
ta set 2 - IBM Support Assistant Workbench
Fle VGCHeap Data VGCPause Data VGC Data Admnistation Update  Views Window  Help GC MOde Optthmpm
Support As: Largest memory request (bytes) 19496
Mean garbage collection pause (ms) 1514
- Templates 52| == 0)C pamset2 o Mean heap unusable due to fragmentation (MB) 0.0
@ Un-paused Time Mean interval between collections (minutes) 0.04
C;)Pe”c’rma_”“ Number of collections 208
oo Chiect Sizes
B Mative Memory ——Compacttimes| Proportion of time spent in garbage collection pauses (%) 57.9
abremory 2,500 :.spjvu;ee;‘truﬂnimwwm i i i Proportion of time spent unpaused (%) 421
cFoLOA and GOA Sizes ’ __Prark times - - :
S Generational Heap Rate of garbage collection (MB/minutes) 126
D%Fragmentanon
@ Compaction Pauses '
2,000
g \ m
| ’il |
|
[El Key 28 =B I ‘ }H |“ ‘ | i
[ Variants || ‘ l I | ‘| ‘l
1,000 | ‘ I“ J| I I‘“ I ”
—verboseGC.STC226 74,5750 ‘ L L HL‘ L‘
rData 500 l l
[ | Compact times T
I |Fause tmes (not including excl N R B e 1] ]
I | 5veep times sl
— Mark times 00 05 10 15 20 25 30 35 4ﬁt:ne Elrﬁ?HUtei? 55 &0 &5 70 75 80 B85 90 g
al | » 1l varboseGe STC226 74 SYSOUT xml [Ranart [ Tabhed data || ine nint [ S ch red daral
Pattern Modeling & Analysis Tool for Java GC (PMAT) ., .x«
Different perspective than GCMV - PMAT does not run in the ISA
workspace. When you click Next, a separate display appears.
&0 x|

File Analysis View Help

S| x % x| [B[8]u s[5

3] a] [E] 2] ==

@[m]

(= File List

irst Garhage Caollection

Last Garbage Collection AFIGT

é‘ iISEQWDEWQZ?QDDB

|Tue Sep 1 09:53:51 2009 |5050 1

Start time (HH:mm:ss MMiddiyyyy)  [02:12:37 0901/2009 | Open ‘ | Close

ms

End time (HH:mm:ss MMiddiywyy)

09:53:51 09/01/2009

# File name : C\Traces\ToyotaGCverbose2 xml

# Number of all Garbage Collections : 50

# Number of Global Garbage Collections : 50

# Number of Scavenger Garbage Collections : 0

# Elapsed time between start and end time : 6,084 seconds

# Total Garbage Collection duration : 36 seconds (0.6021531886916502% of elapsed
time between start and end time)

# Average Garbage Collection duration : 732 milliseconds

# Total Global Garbage Collection duration : 36 seconds

# Average Global Garbage Collection duration : 732 milliseconds

# Total Garbage Collection interval : 6,048 seconds

# Average Garbage Collection interval : 120,974 milliseconds

# Total Global Garbage Collection interval : 6,048 seconds

# Average Global Garbage Collection interval : 120,974 milliseconds

# Total collected bytes by Garbage Collection : 7,884,800,020 bytes

# Average collected bytes by Garbage Collection : 157,697,818 bytes

# Total collected bytes by Global Garbage Collection : 7 884,890,920 bytes
# Average collected bytes by Global Garbage Collection : 157,697 818 bytes

40,000,000

2200

1,200

200

i

08:12:27  08:22:35  02:3243

02:47:52

08:6300 030308 091317  09:2835 093334 094342 095361

fotal TenuredAfter

| Tetal TenurediBet

[zed HurseryAfte

| Total Nursery #ter

| Tatal Nursery{Bef

fiequested

#| [ Fra=S0Afer

FreeS0a(before

| [FreeLOafter

Total 5 OA(fter

TotalLOAbefore )|
AF Completed
Srreey

[5G Gompicies |

Overhead
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JVM Dumps - Many kinds . . .

e Java Dumps > /var/home/...

— Heap
— JavaCore
— JVM TDUMP:

e SVC Dumps, ABEND Dumps, SYSABENDs
. CEE Dumps

Analysis Tools:

« MDD4J - high level — good for “Leak Suspects”
 Memory Analyzer — More detailed

e Dump Analyzer

* Heap Analyzer

e Thread & Monitor Dump Analyzer for Java (TMDA)

See “Analyzing Dumps” in appendix for more details.

712712010 SHARE 115 - Boston © 2010 IBM Corporation 1

=
Memory Dump Diagnostic for Java - V3 (MDD4J3) =«

 Focus on data structures that may cause memory related problems.

* Analyze heap dumps:
— “Baseline” heap dump — take when application is started.
— “Primary” heap dump — when a problem occurs.
— “Comparative” heap dumps — analyze differences.

Memory Dump Diagnostic for Java
Vi
Leading edge heap dump analysis for today's memory problems. il

Open  View Help Release Notes

Analysis Summary ~ Reach Size Leak Suspects  Object Tables  Data Structures

Heapdump: ' [
C:\Traces\heapdump.20090925.143726.197112.0001.phd /
e Date generated: Fri Sep 25 14:37:26 EDT 2009

HTML Report Yeti Report

Websphere.miscellaneaus:
15MB (31.3% of the heap)

ell
share
ipse.miscellaneous
M Model =
4] ILI_I
e For detailed instructions on how to use this tool and other tools Type Breakdown &
to diagnose a memory leak, see the Getting Started help

Quick tips

section, and other sections under the Help tab above. — ;::,:‘Dg
longl]
Examine the Predefined Components and Type Breakdown = ;:L?D
graphs on the right to see if there are any very large or B HashMap3Entry
M HashMap$Entry[]

abnormal contributors to the heap HashtableSEntry

e Switch to the Reach Size Leak Suspects tab above to see a :‘;2':::"”3“5"‘”

numher of notential siisnects in case nf a leak

712712010 SHARE 115 - Boston © 2010 IBM Corporation 12




MDD4J analysis (cont’d) suame

» Guided Activity Assistant
— “Summary” — Basic Heap Info & Contents Summary.
— “Reach Size Leak Objects” — Cumulative size of all objects.
— “Object/Class” leak suspects.
— “Data Structures view” — Understand relations & Track Changes.
* Big/Growing/Shrinking/Steady
* Yeti Reports: (HTML or Yeti zip file)
— Save as HTML file, or Yeti analysis zip file — extract & open iIndex.html file.
— Analysis engine based on "Yeti" technology.
* Overview
» Health Report
» Content Graphs — Type & Field layout views

e Additional documentation:

— Techdoc WP101612 — “Getting started with GC, Heapdumps and Javacores for
WebSphere on z/OS”

— DeveloperWorks Summary doc:
www.ibm.com/developerworks/websphere/techjournal/0909_supauth/0909_supauth.html

7127/2010 SHARE 115 - Boston ©2010 IBM Corporation 13
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. s
Yetl Reports (from MDDA4J)

Extract zip file created by MDDA4J, & launch index.html

Data Structures: | Big ‘ Growing H Shrinking || Steady ‘ Overview || Health Report
servietwrapperimpl [N 472ME [Surmmary of all live objects in the heap.
HTODDynacache 4.67MB ‘There are 512MB of live ohjects, of which BOMB is overhead,
JmixPBean3erver etal, 341MB
SysternState etal, 3.18MB Predefined Components Type Breakdown |
ResourceBundle class o.. 2.66MB ]
Wehsphere miscellaneous Ha‘ﬂl
shared Strings Ll [ Tl Documents and SettngsHutchMy Docun
H — eclipse.miscellaneaus it ™
Analysis Summary Report — e B
M Modeling.emf M i This schérrutic sxplains $7IME.
W EMmiscel llaneous N sy
W ‘Yebsphere security [_Je!
OpenfClose all major sections | Open all sections I _ m”‘
PTLllg
U Primary heap file info [MemWorkout§Bich]
u C:\AppTraces\heapdump.20091013.140817.196909.05 Big Data Structures
K Bore
Heap Contents Summary Description Size |Reachable Size | Shared Size
com.ibmws security weh WebAppCache class ohbject 446kB 230MEB 229MB
Aggregated Data Structure Leak Suspects corn ibmws webcontainer serviet ServietWrapperlmpl 207TME | 20TMB 0 bytes
E com.ibmuws cache HTODDynacache B16ME  |8.16MB 0 bytes
— Object/Class Leak Suspects com.ibmws management.descriptor MBeanDescriptorManager | 191kB 5.36MB 517TME
org eclipse emf ecore impl EPackageRegistrylmpl class object | 16kB 369MB 367TMB
Big Data Structures org.eclipse.emf.ecore impl EPackageRegistryimpl 147MB | 2.02MEB 1.55MB
com.ibmws naming.ipbase NameSpace 183kB 2.23MB 2.05MEB
WWhole Heap Health Measures com ibmws naming ipbase NameSpace 47kB 2 11MB 2 07MB
com.ibmuws390.orb CommonBridge class ohject 360 bytes | 1.75MB 1.75ME
Javax.managemem modelmbean ModelMBeanOperationinfo 1.BMB 1.65MB S2kB
7127/2010 SHARE 115 - Boston © 2010 IBM Corporation 14




Memory Analyzer ovor)

» Based on open source M.A.T. + DTFJ - www.eclipse.org/mat
* For java heapdumps, System Dumps (jextracted) & javacore*

S " 1M Monttoring and Liagnostic Toals... < |

) A 1/ 8 heapdump. 20050925, 143726.197112,0001,phd 22 |
Getting Started wizard: LA I RS ,
1 Ovendew| Bl cetwt_report ceg.ecipse.matapi-suspacts 11 [

o Overview ------------------ > Leak Suspects

 Leak report System Overview
i Component reports - Leaks

~ Overview

Navigate: (TOC, Fly-over, Click) miove

» Histogram (tables)
e Context (In, Out Refs) A B 5 e Sl

« Group (Pkg, Class, Loader) B 6o
 Dominator Tree

— Objects keeping others
e Path to GC roots
* Leak reports

(9 335 Mg ——————
Total: 435 MB

~ @ Problem Suspect 1

54 instances of "org.eclipse.osgi.internal.baseadaptor.DefaultClassLoader”, loaded by
"org.eclipse.core.launcher.Main$StartupClassLoader @ 0x1b957c90" occupy 5,277,944 (11.57
bytes.

7/27/2010 SHARE 115 - Boston ©2010 IBM Corporation 15
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Memory Analyzer samples

Navigate: (TOC, Fly-over, Click)

* Histogram (tables) Example: Biggest objects by Retained Size:
« Context (In, Out Refs) 8 e oy Aok o]

e Edt Wndow Hep

) Gro u p (Pkg , Cl aSS , Load er) I inspector & | U B heapdump. 20090925, 143726, 197112.0001.phd & © O ||Eche. i € wek... =}

. LD ool e BT Q =
e Dominator Tree ".OD:':" a| | :m:nent
— ObJeCtS keeplng Others Size: 43,5 MB Clisses: 16,3k Objects: 759,6k Cliss Loader: 354 Lreachble Objects <+ Introducion @

Hestogran » Dpen a Heap Dumgy

* Path to GC roots  Blogest Obecs by Retand e D

b GAtting an Overview

&
— 479 3KE 52498 ¥ < @
5 N Cuphcate Strngs z
* Leak reports st PR I e || ) enprycokcars @
Name Wl * Collection Fil Rabios 7
» Soft Reference (%]
Statencs
1 Grverviem| B defilt_repert, oegecipsn mak aptisuspects 7 ' ¥ Finalzer Seatisics @
N, " » Map Collsion Reatios. (8
Table Of Contents ' e
- System Overview
® Heap Dump Overview
ey s 122MB
= Thread Overview
»Top Consumers Total: 41.5 MB
© Biggest Objects (Overview) . -
= Biggest Obiects ~ Shortest Paths To the Accumulation Point -
° Biggest Top:Level Dominator Classes (Overview)
® Biggest Top-Level Dominator Classes N
s 5 —Ley - o ol Shallow Retained
ass Name
Heap Heap
s [] java.util.Linkedlist$Link @ 0x83401c470 48 209,384,520
» Class Histogram
-0 Laaks Aram ") java.util.LinkedList @ 0x83401c448 40 209,384,560
o Dvarvienw ) com.ibm.washington. tai.MemWorkout @ 0x83401b3b0 64 209,384,624
* @ problem Suspact 1 . .
» Doscript] L] com.ibm.washington. tai.Memoryl eak @ 0x833f91150 40 209,384,664
i- ) com.ibm.ws.webcontainer.servlet.ServietWrapperlmpl @
" I 0Ox831eabSe8 240 209,385,000
7l com.ibm.ws.wehcontainer.webapp.WebAppServietinvocatio g a8
nEvent @ 0x833a75828 Unknown
d .ibm.oti.vm. p @
| Sl dden e s 200 128,824

7/27/2010 SHARE 115 - Boston © 2010 IBM Corporation 16




Memory Analyzer sample use case

SHARE

File>Open Heap Dump > Leak Suspects Report > Problem Suspectl >
“Shortest Paths To the Accumulation Point” and “Accumulated Objects”
* There we found the suspect “MemoryLeak.”

i Overwew‘% default_report org.eclpse. mat.api:top_components [% default_report org.eclipse.mat.api:suspects &

el [BE) > B > [ O
lewr | &% defallt_report org.eclipse.mat.apissuspects 52

Shortest Paths To the Accumulation Point

~ System Overview Class Name Shallow Retained
= Heap Dump Overview Heap Heap
B System Properties [ java.util.LinkedlistsLink @ 0x83401c470 48 209,384,520
= Thread Overview " java.utilLinkedlist @ 0x83401c448 40 209,384,560
~Top Consumers
= Biggest Obiects (Overview) 'D com.ibm.washington.tai.MemWorkout @ 0x83401b3b0 64 209,384,624
8 Biggest Obiects . T com.ibm.washington. tai.Memoryleak @ 0x833f91150 40 209,384,664
s Biggest Top-Level Dominator Classes (Qvervie L. 1) com.ibm.ws.webcontainer.serviet.ServletWrapperlmpl @ 240 509,385,000
7 7 0x831eab8e8 e
8 Biggest Top-Level Dominator Classes el
8 Biggest Top-Level Dominator Class Loaders (O E] com.ibm.ws.webcontainer.webapp.WebAppServletinvocatio 88 a8
8 Biggest Top-Level Dominator Class Loaders nEvent @ 0x633a75828 1
o Biggest Top-Level Dominator Packages B com.ibm.oti.vm.BootstrapClassLoader @ T
8 Class Histogram 0x827f42910 System Class *
~ @ Leaks b T Java.util. LinkedListslink @ 0x83326d880 » 45 48
B Qverview i~ ] com.ibm.ws.util.ClauseNode @ 0x831ec8590 » 15 432
~ @ Problem SUS ect 1 Z Total: 3 entries
8 Description
—— = Shortest Paths To the Accumulation Point )
8 Accumulated Objects * Accumulated Objects
8 Accumulated Objects by Class
Class Name Shallow Retained Percentage
Heap Heap
ke Of Contents Created by Memory D‘gig‘g';bprzij"‘i‘WEbC"”tE“”E“SE'V‘Et'SE""EtW’aD”E”’"D‘ ~ 240 209,385,000 77.79%
[} com.ibm.washington.tai.MemoryLeak @ 0x833fa1150 40 209,384,664 77.79%
-——".rlg:;ﬂs.iaonlsv;absohlnqtcn‘ta\.MemWorkcut @ 64 209,384,624 77.79%
[Jjava.util.linkedlist @ 0x83401c448 40 209,384,560 77.79%
7127/2010 SHARE 115 - Bostor Zors oMo pur aaun —
Dump Analyzer b

Select report, “Analyze”
— Click on WASBasicInfo . . . or

1.LUMP.DO91014.2ip) - [BM Support Avsistarit Workbend

Bl fdmrematon Lpdate Wndow  Help

Tl Lorster | ] ViASBasknfoSYSLOUNP. CO31014.p) 51|

Based on JVM’'s jdmpview tool
System dumps processed by jextract
FTP to workstation (binary)

Import dump — “Browse”

& Launcher - IBM Support Assistant Workbench

File  Administration

Support As

Update Window Help

'm| Launcher}

System dump file: | C\AppTraces\sSYs 1L.DUMP.DO91014.2ip

&

- WebSphere Applcaton Server

& General
- WASBasicInfo, 1.0.0.20080310: Basic information aboLt 8 WAS server process
WASHeader, 1.0.0.20080310: Print a header with commaon information about a W,

WASThreadIDs, 1.0.0.20090307: Print a list of all threads with their Java and WAS

WASTHreadPoolsBasic, 1.0.0.200803 10; Basic information about threads and threa

MSVHSIOHJ 1.0.0.20090307: Basic information about version information in a Wa:
lized analyzers for version 7.0

dtf].analyzer

comiom,dif} anchzer was WASBaschD

2.1.2. Summary Information

Deployed applica
Humber of dep:

14

Number Enterprise Applicat net atarted:
Humber c d WAR i 13

Number WAR not started: 0

Number EJB

Number of deployed EJB not started: 0

Threads and thread pools (3ee section below for mors detai
of deadlocks detected:
umber of Java threads (in peola and not in pools

Number
Total n

Current hung thread detection threshold (msec): &00000

Current number of threads suspected of being "hung": 0

mum configured pool sizeas 7

and modules (see section below for more details):

0

la):

): 52

1 zize:
0

Number of Java threads not in a WAS thread pool: 35

Number of native threads not associated with a Java thread: 4
Number of WAS thread pools: 2

Number of pool threads currentl ive: 1

Number of located: 17

Number of re sxcseding m

Number of threads currently i 3 that are at

Number of threads currently 3 t are at owver 100%
Number of threads currently in 3 that are at over 1

50% the maximum pool size:

1ation about the System Management subsystem in a WAS server process
scription avalable)

ameters:

CMNAppTraces\s.

== Upper-rt corner of screen

Save ReportAs.. *e Save Report as...
— HTML, XML, txt

* Save Log as ...13

Save Log As...

Shioi Log
IBM Corporation




Dump Analyzer — Analysis Reports SaveRepm-) -
- Save Report As: html, xml, or txt files v Lo s
- Default Dump Report: Show Logg

2. Analysis results
DumpAnalyzer V:2.2.2.20090926232659 : Start analysis of C:\AppTraces\SYS1.DUMP.D091014.zip

2.1. Results from Analyzer=com.ibm.dtfj.analyzer.jvm.DefaultDumpReport_Standard
Analyzer full name: com.ibm.dtfj.analyzer.jvm.DefaultDumpReport_Standard
Analyzer version: 1.3.0.20070812
Analyzer description: Report basic information from this JVM image (similar to javacore) - Standard version

2.1.1. Image and runtime information

Now reporting on runtime: 0.0.0
Image: (no identity)

Time of dump: Wed Oct 14 02:28:14 EDT 2009
System Type: z/OS System SubType: 01.10.00
Processor Type: s390x Processor SubType:
Number of Processors: 2
Installed Memory: 6442450944
Host Name: wsc2
IP address: /9.82.24.70
This Image contains: 1 address spaces; 1 processes; 1 runtimes

Process: PID:0x30208
Executable: main
Command line: [<null>]
Pointer size (bits): 64
Signal that triggered this dump: 0 ((no signal info available, or dump was not triggered by a signal))
Current Thread: 0x14b06000

Java Runtime: JavaVM@0x000000080B178548
Java Version: Java(TM) SE Runtime Environment(build pmz6460sr5ifx-20090623_02 (SR5)) IBM J9

2.1.2. JVM Initialization Arguments
JNI ignoreUnrecognized: False
JNI version: 65540
-Xthr:tw=HEAVY Extralnfo=0x00000000

~
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HeapAnalyzer (New on ISA!) '1

e Oiriginally provided on AlphaWorks

» Graphical analysis of javacores (heapdumps)

e Creates tables & graphs

» Heuristic engine to find memory leaks and excessive heap usage.

‘Working Cirectory:  C:\Documents and SetingsiHutchyBMYSAv4 1iapplicationsieclipse\plugingicom.ibm.esupport. tool. heapanalyzer_3.9.8.00
Cancel C:\Program FilesbmyBM Support Assistant
Command Line: w4 Lycpiecipsetpluginsicom.bm rep.j2se.wind2.x86_1.6.0,20090211a-20090330132 Ijretbinijava.exe -Xmx1024M -jar ha.jar
"CiiTraces\heapdump. 20090325, 143726, 1971120001, phd"

- Tool's stdout and stderr [ LSRR el EC =1alx]

File Analysis View Help

|w] [~]a]E]=] [~ [a]e

z||=]=][1]>]

5 Analysis of heapdump.20090925.143726.197112.0001.phd :
Froperty Walue
Heap dump file name CiTracestheapdump. 200909251437 26.197112.0001.phd
{lyava version JZRE 6.0 Z05 5390
IMumber of Classes 16,320
MMurber of Objects 506,690
MMurnber of Objectarays 97 585
—Output Artifacts \[Mumber of Primitive&rrays 139,171
{[Total Mumber of Instances THO,BTR
I {[Tatal Mumber of References 1,423,751
{[Mumber of roats 159,814
IMurmber af types 16,322
IHeap range 1 b7 24000 to %1 e3e3em
{[zva heap usage 45 002,856 bytes
|Dark mater 1,072 bytes (0.0023773168 %)
'

CJ Console
[Tue Dec 08 17:51:51 EST 2008) Heap Analysis of CiTracestheapdump.20090925.143726.187112.0001 .phd completed in 00

] 1] [ [
- — HeapAnalyzer
7127/2010 SHARE 115 - Boston © 2010 IBM Corporation 20




HeapAnalyzer (cont’d) -

Al view Heip

o o Ana|ysis Views: Locate a leak suspect x|

= Objects List — Tree view ®

Located a leak suspect

EZ Types List H H

E':; oot st — Objects List javalutiliLinkedList $Link ( count : 340,599 )
° Gaps by size — Types List is responsible for 209,383,848 hytes

4 Search Name - GapS by size OK

lo% Search Address

&l -1o| x|

File Analysis View Help

(9] [~ ][E]8]=] [~][%] [a]e] [=]2] [=]2] [1]>]
& heapdump.20091013.140817.196909.0011.phd Tree View : : o o B4
Subpoena Leak Suspect(s) Go to Bookmark Remove Bookmark : £ com/ibm/wsspiwebco...
™, [209,434 080 (78%) [32] 1 comifibmiws spitwebcontainerutililURIMapper 0x306h3d58| Property Walue
o € 209,434,048 (78%) [56] 3 comiibmiwsspitwebcontainedutilfURIMatcher 0x306b3d78 : Address UXBUl_ﬁdeSS
o 200,405,272 (78%) [56] 2 comiibmfwsiutilClauseMode 0x306b3ed0 Marme cornfibrmws. .
o 28,288 (0%) [72] 1 javalutiliHashMap 0x306h3db0 Murnber of .. |1
o€ 432 (0%) [56] 3 comiibmiwsiutiliClauseMode 0x31f58860 Murnber of p... |1
o 272 (0%) [30] 2 comiibmiwsiutilClauseTable 0x311588c8 : OwneradFire... Dx30§?8dcﬂ
o 104 (0%) [48] 1 javallang/String 0x31158808 Owner object |cormibrafwss..
o= 4,264 (0%) [144] 12 comfibrmbwsiwebcontainerextensioniDefaultExtensionProcessormpl 031137280 ¢|Size 32
2| Tatal size 209,434 080

See detailed information of a node; search for total size drop between parent and child.
* Tree node format: TotalSize(Size/Heap%)[ObjSize] #ChildObj (# root obj) Name Addr
« Select a node and right click to find an address.
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[

Thread & Monitor Dump Analyzer for Java (TMDA%-H.&EE

TMDA for Java analyzes javacore dumps and helps you find hangs, deadlocks,
resource contention, and bottlenecks in Java threads. (Tech preview.)

Webcast & Foils. ibm.com/support/docview.wss?uid=swg27011855

Number of Threads : 59 | Percentage
Features provided & Color coding: ne)
* Summary of Javacore 77 (%)
* Thread detail view 8 (%)
* Monitor detail view 0 (%)
» List of hang suspects I suspended 0%
* Thread compare view & Object wai() 0 (%)
* Thread comparison summary 5 (%)
* Monitor lock compare view 2(%)
» Garbage collector statistics for IBM JVM
IBM Thread and Monitor Dump Analyzer for Java B ==
File Analysis View Help
i I =
x| x| x| #|R%B w2 [=]2] [2]i] @romame
=
T — T - |
Hamz & ; :l Free Java heap size: 25,168 bytes =
Health Center trace i
UIT Compilation Thread : .
o pomwllation Tivead ____ | lo Aiocated Tava heap size: 268,435 456 bytes
WIMX server connection timeout 96 E P
LocalNotificationServiceDispatcher : 0 -| @ Memory Segment Analysis
lon-Deferred Alarm Manager :
i Memory Type |# of Segments | Used Memory(bytes) | Used Memory(%) |Free Memory(bytes) | Free Memory(%) | Total Memory(bytes)
Internal 312 26,722,036 1563 47,377 524 64.37 73,599,860
.
] Obert 1 268 435 456 100 il 0 268 435 456
Class 1,856 £2,120,372 70.97 33,635,508 20.03 115,855,880
RMiScheduler0) &
JIT Code Cache 3 25,165,824 100 0 0 25,165,824
JIT Data Cache 1 3,786,552 45.14 4,602,056 54.86 | £,388,608
]
1lRmTcP ¢ 20)9.51.130.74 | Overall 2,183 405,330,340 5258 35,615,388 | 1742 401,445,628 22
RMI TCP Connection(21)-9.54.139.74 4 :
B ; Sty Sedrabat (el S




Working with Traces from WAS on z/OS ’E:i

« STDOUT & STDERR traces usually go to JES logs
— Keep them off SYSLOG by specifying separate DD files
— May be re-directed to HFS files — TD103695
— Not suited for ISA trace analysis tools

 javatracing - enable dynamically:

— Modify (F) MVS commands:
« F server,tracejava=‘com.ibm.*=all’
» F server,tracedetail=(3,4)
« F server, TRACEINIT

» ffdc logs — automatically generated
 wsadmin.sh tracing — modify wsadmin.properties file

« JDBC tracing — db2. jcc.override.traceFile=in
DB2JccConfiguration.properties file

7/27/2010 SHARE 115 - Boston ©2010 IBM Corporation 23

=
TRA - Trace and Request Analyzer for WAS:ux-=-

* Here’s a Gap Analysis for the addNode.log:
(Works with trace files from wsadmin logs.)

3 IBM Trace and Request Analyzer for WebSphere Application Server

File Analysis Ci ized Analysis View Help
Trace Gap Analysis s
Timer... Trace F
T2,494 [[98/08 151238376 EDT] 00000000 AdminToal A BEOOOZZZE ADMUODZZ) Mode Agent launched. Waiting for initialization status. 107 a..|=-
[9r8/08 15:13:80.870 EDT] 00000000 AdminTool A BBOOO2Z221 ADMUDOI0N Mode Agent initialization completed successiully. Frocess id is: 000002ac00000002 108 a
A5,457 |[9/8/0815.11:12:337 EDT] 00000000 AdminTool A BBOOO2321 ADMIIOT 201 isclite on BLA will not be uploaded since it already exists in the target repository. 38 a
[5r8/08 151 2:07.794 EDT] 00000000 AdminTool A BBOOO2221 ADMUODT Gl Synchronizing configuration between node and cell. 39 a
20 879 |[9/8/0815:12:07:794 EDT] 00000000 AdminTool A BBQOO2221: ADMUO01 6L Synchranizing configuration between node and cell. 39 a
[5r8/08 15:12:37.673 EDT] 00000000 AdminTool A BBOOO2221 ADMUODT 81 Launching Mode Agent process for node: hZnadeb 105 a
20 249 |[9/8/0815:10:34:5944 EDT] 00000000 AdminTool A BEQOQO222): ADMUDO0S!: Successfully connected to Deplayment Manager Server: wsc2 washington.ibm.com: 24010 21 a
[9r8508 15:11:04:193 EDT] 00000000 AdminToal A BBOOO2221: ADMUDSOS): Servers found in configuration: 22 a
G967 |[9/8/0815:12:27:595 EDT] 00000001 FileRepositor A BEOOO2221 ADMROO111: Document cellsth2eelliPolicySetsAWS-1 REPIpalicySetxml is deleted. 102 a.|l=
[9r8/08 15:12:34.562 EDT] 00000001 NodeSyncTask | com.ibmaws. management syne.ModeSyncTask doSyne ADMS00031: The configuration synchronization completed su... (103 a
4920  |[9/8/0815:10:25:076 EDT] 00000000 ModelMgr | BEOOO2221:WEWROB01I: Initializing all server configuration models 18 a
[9r8/08 15:10:29:996 EDT] 00000000 S5LConfighana | BEOOO222): CWPKIOD2TI: Disabling default hostname verification for HTTPES URL connections. 19 a
4503 ([9/8/08 15:10:29:996 EDT] 00000000 S5LConfighana | BBOOOD222): CWPIKIOO27]: Disabling default hostname verification far HTTPS URL connections. 19 a..
[9r8/08 15:10:34:499 EDT] 00000000 AdminTaoal A BEOOO2221: ADMUOODT |: Begin federation of node h2nodeb with Deplayment Manager at wsc 2 washington ibm.com:... |20 a..
3,266 |[9/8408 15:11:05:883 EDT] 00000000 AdminTool A BBOOO2221: ADMUO01 Sl Backing up the ariginal cell repository. 27 a
[5r8/08 15:11:09:145 EDT] 00000000 AdminTool A BEOOO2221 ADMUODT 21 Creating Mode Agent configuration for node: h2nodeb 28 a
1,279 |[9/8/0815:11:04:293 EDT] 00000000 AdminTool A BBOOO2221 ADMUZ0101: Stopping all server processes for node h2nodeh 24 a..f—
[9r8508 15:11:05:572 EDT] 00000000 AdminToal A BEOOO2221: ADMUODST 21 Server h2sr01b cannot be reached. It appears to be stopped. 25 a
TES [9r8/08 15:11:10:527 EDT] 00000000 AdminTool A BEOOO2221 ADMUODT 41: Adding node h2nodeb configuration to cell: h2cell 32 a
[9r8/08 15:11:11:285 EDT] 00000000 AdminToal A BEOOO2221: ADMUOT 200 WehSphereWWSDM on CU will not be uploaded since it already exists in the target repositary. |33 a
K] [9r8/08 15:11:09:149 EDT] 00000000 AdminTool A BEOGO2221 ADMUODT 21 Creating Mode Agent configuration for node: h2nodeb 28 a
[9r8/08 15:11:09:842 EDT] 00000000 AdminTool A BEOGO2221 ADMUOT 200 WehSphereWWSDh. ear will not be uploaded since it already exists in the target repository. 29 a
GE6 [9r8/08 15:12:21:688 EDT] 00000001 FileRepositorW BBOOOZ21W: ADMROT14WW: The systern is overwriting document cellsih2cellivariables xml by request 48 a
[9r8/08 15:12:22:374 EDT] 00000001 FileRepaositor A BEBOOO2221: ADMROO101: Dacurment cellsih2cellivariablesxml is modified. 44 a
3] [8r8/08 151237 707 EDT] 00000000 AdminTaol A BEOOO2221 ADMUDOZ0: Reading configuration for Made Agent process: nodeagent 106 a
[8r8/08 15:12:38:376 EDT] 00000000 AdminTool - A BBOODZ221 ADMUDDZ2(: Mode Agent launched. Waiting for initialization status 107 a
a75 [8r8/08 156:12:25:886 EDT] 00000001 FileRepositor A EBOOO2221: ADMROO101: Document cellsihZeellicusiibmasyncrspicverBASE cuxml is modified a8 a
[8r8/08 156:12:26:461 EDT] 00000001 FileRepositor A EBOOO2221: ADMRODOSI]: Document cellsihZeelliPolicySetshsS-1 REP NDfpolicySetyml is created =] a
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Log Analyzer —
Importing Logs

Tivoli Log Analyzer opens in a new window

i Log Analyzer
File: ety Tools  Help

. . Log Analyzer :
Click on File = Import Log from local system “ § importLog...
. L Import Context... Cl+T
Select log file > Symptom Catalog (WAS V.7) - Finish §oImport Symptom Catalog...  Cirl+1
Wsad min Iogs’ VerboseG C B choose Candidate Log Types él il
Choose Candidate Log Types
Import from the local system Choose the log bypes that you think might apply to this log file,

Import log files from the local file system.
Filter

type in alog types fiter « ¥ Show categories

Cirectories and Archive File Directories: 1 X
- - Fiter Pattern: | [J:2 181 Integrated Sclutions Consale 1 Highlight Events
(23 Techdocsy7 o [ ] D@ IBM 10K
E-£3 Tools Filz Mame Sl Highlight Events
3 dtfj-updatesite ) Classification® DE'O IBM JDK ge log )
o 15h YCE e HZSRO1BS.S 30 1M 10k Javacore log Select filter to enable event highlighting
& [SAEIIe4 1 ) JavaHeapdty [J® BM 10K trace log and edit color in color edit colurnn,
£ JaveDiagnastic S Quickstartht [J#® 1M Lotus workplace Fiter | color
: £ matdtizip wgﬁT&‘ O:#® M o500 15 Show error lng recards anly
L e wescc oot ] | Do 07 18M Rational [1 5 show exceptions, stack traces or falures Abe...
q | 5 q L] 18 Storage Area Metwork [ 5 show information log records anly Abc. .
D{? BM S t Assistant [ & show non-ReportSituation errors/warnings Abc...
:0 Hpport Assistan [1 5 Showr warning and error log records Abc...
Character Encoding; [DEFAULT. L% 1w Tivol [ & show warring log records anly Abc.,
= [FE0 1B webSphere Application Server
Loca decompression wliity execta | [J:#® 181 websphere Application Server (WAS) activity log
[J:#® 1BM websphere Application Server (WAS) Collactor lng

0@ 18M webSphere Application Server (WAS) FFDC log

Logs to be imported into Log Analyzer:
[:#® BM WebSphere Application Server (WAS) for 2/0S Companent trace log

File Mame | Log Type | Fil °
T 2 IBM websSphere Application S: AS) fi 05 I
H2SRO1BS.STCZ22057.GCverbose. ... IBM DK ge log == DE’ ebSphere Appication Server (WAS) for 7/ erorod

[J:® 1BM websphere Anplication Server (WAS) native stderr log
[M1:® 181 WebSohere Aoplication Server (WAS) plugin loa
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Health Center: i

Real-time Monitor with low overhead

* YouTube videos
1. Overview of Health Center features
www.youtube.com/watch?v=5TcktclOgxs
2. Install IBM Support Assistant and Health Center
www.youtube.com/watch?v=6W|E9UOjVEK
3. How to enable a Java application for live monitoring by the Health Center
www.youtube.com/watch?v=HdpOmJ13NLQ
* Enabling a server (very easy!):
— Add —Xhealthcenter to servant JVM properties
* Updating the healthcenter.jar file
— Download, unpax & copy the z/OS agent pkg (mz64.pax) from ISA Help
e Using: Launch from ISA with host & port (1972)
* Views:
— Classes
— Environment
— Garbage Collection
— 1/O (New!)
— Locking
— Native Memory
— Profiling

See also SHARE 113 (Denver) Presentation — Session 1153
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Health Center - Profiling

e Lower overhead than Jinsight Live for z, but not as rich.

jon paths (Methods that call SimpleCIWork.run()) - IBM Support Assistant Workbench
Update Data Window Help

File  Administration

Support Assistant

X

[2 status = 8| @ method profie £ | =0
© Classes @ Filter methods: I Al gearl
® Environment )

I Garbage Colection & Samples « | Self (%)l Self Tree (%) | Tree Method =
— 25679 92.9 93.2 com.ibm.websphere. ci.samples. SimpleCIw—!
= © B84 0.3 0.38 jawa.lang. ClassLoader defineClassImpl{java
& Locking (V] 80 029 0.29 java.lang.String.lastindexOfiint, int)

] 44 0.15 0.2 java.lang Math.random)

Lat's Memesy. @ 3z 012 0.15 org.apache.xerces.dom NamedhodeMaplr
1% Profiing L] 28 0.1 061 Jjava.lang. JSVMInternals.initialize (java.lang..

B3 Connection &2 =g 27 0.098 0.17 com.ibm.of.ym. M. indClassOriul Gavalar

l— 27 0.098 0.098 org.eclipse. xsd.utl. XSDConstants. node Tyt

25 0.09 0.41 Jjava lang. ClassLoader loadClass (java.lang.

. 22 0.08 1.54 | org.eclipse. xsd.impl.XSDConcreteCompor

= 3'2551'51?:2::;3 16 0.055 0.25 java lang. 1SvMInternals. verifyImpljava.lan

Last updated 14 0.051 0.3 org.eclipse.osgibaseadaptor.loader Classp:
09:10:37 13 0.047 0.03 java‘textCol\ationEIememt[terator.next(ilﬂ

«| | »

T Analysis and Reco.,, 2|5 0

-~

2 The method

SimpleCTwark.run() is
CONZUMING approximately
93% of the CPU cycles, It may

ClControllerwork.run (100%)
JZEEContext$RunProsxy.run {100%)
D AccessControler.doPrivileged (100%)

@ Invocation paths 22 4 Caled methods | < Timeline | -
Methods that call SimplecTvwork.runiy
2 @ SimpleCTwork.run | -

be a good candidate for

optimization, =@ J2EEContextrun (100%)

-l

Automatic Updates: (41%)

7/27/2010
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Health Center - Classes

« Timeline shows Class Loading frequency

7/27/2010

@Status - IBM Support Assistant Workbench = =1
Ele Administration Update Data  Window Help
Support Assistant
4 |Eloed &b
(2 Status 23 I = O || @ Class loading timeline &2 =
@ Loaded classes
® Ervironment )
T Garbage Collection @ 0:00 0:05 0:10 0:15 0:20 0:24 0:29
time (minutes)
) Locking @ EG Classes loaded 23] =
Filter classes: Apply || Clear
1% profing ® I J J
Time loaded = | Shared cache | Classname LI
[ Reduce profiing ovarhead 000 Mo com/sunfamlinternal/bind v 2fruntimefproperty/TagAndType —l
000 MNo comfsundmlinternalfbind i 2fruntmeMName
= 000 Mo camfsunsxmlinternalbind v 2 runtme freflectLister
= (=]
Sicconmagdation 000 06 com/sunfxmlinternalbind /v 2fruntime freflect/PrimitiveArrayLister
@ o application has loaded 1,747 =i | 000 ] com/fsun/xmlfinternalbind v 2 runtme freflect/PrimivesrrayLister
00 Mo comfsunsmlinternalbind i 2runtime freflect/PrimitveArrayLister
classes, 000 06 com/sunfxmlinternalbind /v 2fruntime freflect/PrimitiveArrayLister
6] Some meritored data was dropped in 0:00 Mo cormfsunixmlinternalfbind fv 2runtime freflect/PrimitveArrayLister
" b A b 00 Mo comfsunsmlinternalbind i 2runtime freflect/PrimitiveArrayLister
€ VM being monitored becalse it was — || |00 Mo com/sunfxmlinternal/bind /v 2fruntime freflect/PrimitiveArrayLister
produced at & faster rate than the Health apn Rl e Je i1m B el Aartn 2l A 172 ) i s e flort DrimiHy e re s i lear
Center client was able to consume, This 4 r
Arnimmed Aata mickt have inch ided LI
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Health Center - Environment

» Verify environmental variables, and Classpath setting

7/27/2010

File  Administration

ant Workbench

Update Data Window Help

[ Reduce profiing overhead

[2 Status 22 ] = 0| = Configuration &3 1 [ System Properties ‘ [ Ervironment Variables| =4d
Property = | Vallie o
© Classes ] Boot dasspath
Classpath
® Erironment o Bl Java parameters b
e -Dicom b, CORBA liop.noLocalCopies=false
-Dcom.ibm.itp location=/wasv 7config/2celhznodeb/AppServerbin
T carba 26 Colection @ -Dicom.br.of vm.baotstrap.ibrary path=fwasy 7confighzcelhznodeb/AppServer fava
-Declipse.security
-Difile. encoding=I15C08859-1
@ Locking & -Ojava.awtheadless=true
-Djava.class path=fwasy 7confighZeelh znadeb/AppServer fprofiles/defaultioropertes: i
-Djava.ext.dirs=fwasv Fconfigzcelhznodeb/appServer fjavalibfext
18 Profiing @

KN —

-Djava.ext.dirs=fwasy Fconfighzeelh znodeb/appserver favadibiext: fwasy Feonfighze -
»

, Java Virtual Machine 52 1 = O || cfl system 2 ] =
1 configuration Recommendations 52 | = 8| | Broperty = [ value Property = [vaie |
:I Full wersion J2RE 1.6.01BM 19 2.4 z/C||| Architecture 5330
® The aption -Xthr tw=HEAVY is ot a Java home wasvIcanfigizeellihzne ||| Number of avalable processors 2
Java vendor IBM Corporation Operating system /05
ted option.
SUpported ophien Java virtual machine name | [BM J3 WM Operating system wersion 01.10.00
Process id 196834
Wersion 18
| Y |
29
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Health Center — Garbage Collection

» Graph shows Heap Use, Size, and Pause Times

7127,

ause Times - IBM Support Assistant Workbench
File Administration Update Data Window Help

Support Assistant

&l 1ol x|

YR Oy Y
Vi \‘“ = gjfm: o

s

I Garbage Collection x

[£ Stanus 22 |

Used heap (after collection) I = O || &5 Pause Times & } =0
© Classes ] . . . . .
Used heap (after collection) and Pause times (not including exclusive
® Environment &
[ Garbage Colection @ 250 (Used heap (after collection)— 200
=0 © Heap size—
_ 200 150
5 Locking @ g g
Native Memory @ £ 150 :17
g 2 100
W profiing & ‘» 100 =]
T4 Comnection £ | == 50 /I/—/—/// 0
= 9.082.24.69:1972
:I:# 24 MB received 0 0
——— = 0:00 0:30 1:00 1:30 2:00 2:30 0:00 0:30 1:00 1:30 2:00 2:30
18 Analysis and Recommendations &2 =] . B . .
— time (minutes) time (minutes)
@ The mean occupancy is 13%, Thisis abitlow, 50— = summary 2 1 5 Qbject A\Iocanons‘ =5
voLl have room to save space by lowering your heap size a | |
if neecﬁed. IIov‘:Jer\mg mfe heap swzeI vﬂ\ﬁprgbib\y degrade ‘Alocation falure count )
g;eer: application performance slightly but improve pause &C Mode Defait (opttruput)
} Largest memory request 8.02 KB
© The garbage collection is performing system (forced) Mean garbage collection paise 108 ms
GC3. 42% of the GCs were system GCs, The use of ficanliican qunsab\e arg F Magmeiton 10.9 VB
system GCs Is generally not recommended since they can EE m_terva _etween COlECTIONe 047 mintes
cause long pauses and do not alow the garbage collection Froportion of time spent Lnpaused 99.5%
algorithms to optimise themselves, Consider inspecting Rate of garbage collection 317 MB/mirite
your code for occurrences of System.ge(). System (forced) garbage collection count 3
Time spentin garbage collection pauses 0.44%
Analyzing €
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Health Center — I/O View

o Graph shows Number of Files Open over Time

SHARE

[ Qpen Flle detais 2 ‘

£ status 23 | [ Files open 22 | 1 Fie 10|
1© Classes] M H
............ Files open
® Envirenment &
i Garbage Colection & 7.0
St} ® 5.0
& Locking 9 )
= 50
MatveMemory @ g
540
1% Profiing & 5
— tz0
54 Connection &2 ‘ - B d
20
10
= 98224691972
28 MB raceived 00
Last updated 10:01:02 2:30 5:00 730 10:00
time {minutes)
=0

[ Analysis and Recommendations &% ‘ = O

File name fiiter: |

denl |2

® Your application has opened 286 fles

E

Open time = | Flle name
and closed 754 fils. 4:42 minutes fasv Tcomfigib7cel o Tnodea/AppServer forofies defalitinstaledApps b7 cal SSimpleCIE ar 2ar fSimpleCIEArETBS. Jar
4:43 minutes Snasv Toonfigb7celb?nodea/appServer forofles/defaultinstaledapps b7 cel XDOGIVT ear KDCGIVTEIBS. jar

7/27/2010
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Health Center - Locking

SHARE

 Identify Lock Contention and avg. Lock Hold Times

7/27/2010

Fle Administration Update Data Window Help

Ll 4

lnck could resylt ina nerformance

[ Status 83} = O || [li: Moniters bar chart 52 v =0
Inflated Java Monitors
© Classes ]
Slow (height) and % miss (color)
T [ ] E I & T E 2 E T T &
® Environment & S40]8 £ L é S £ £ 35 8L E 3 é E 5 T 5 & E
5 - e B e 5 £ 2 2
E |£ 288 fEFE 5 ygE £ g T i 2 =
E-E- T B T F £ E T & F E ¥ E-F - =
T Garbage Collection @ § ;‘:'E 8 3 g £ = 5 & 5 9§ £ =] E £ 5 g £ = &
= = 32 = 2 = £ = & 2 Z
g S5 E2 555 EF 555855 P55 5
~ [} = I = I = R = == = S ===
& Locking & = 825 38835985z 32deLdlEs s ny
H g ¥ g ap s d iRz {8 E g B spogd
w e ol = T
T h Lf H8 4 5 B/ 50 6 F F F L S PR F A F
1% Profiing @ 200
Monitor
[~ Reduce profiing overhead
= Inflated Java monitors analysis 52 = 8| % Monitors 23] 2> =0
8 Inflated Java Monitors
& 42r41010) =
) . % m\ss| Gets ~ | S\ow| Recurswel % quI Average hold tme | Marne ﬂ
comflbmf]vTﬂnterruphb\eI_OContext@27EC ) 5573 ) ) ) T [3D25[—'
FFe0 (Class)" had a high miss percentage 0 1229 0 o o 23719 [4104z
indicating that 36% of attempts by a thread o 1140 o o o BI5S  [I02s
to own the lock (when the requesting 0 1074 o o o 0030 [42899
thread did not aready own it) required the 0 00 a a o 20005 | TAZFFELT
thread to walt. Reducing contention on this [ N T
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Visual Configuration Explorer (VCE) »a=-

Visualize, explore, and analyze configuration information
Correlate configuration information between different products
Collaborate with others during problem analysis

Also see SHARE 113 Session 1153 for more examples...

el Configurations &2 =l
[5e % - &5 5 0

= @ WebSphere.JZCRE&wrceﬂ |

& [ WebSphere JDBCProvide m g

— w

]

+-[2 webSphere MalProvider Provide m‘-

ider
[webSphere ] defa...

= [ WebSphere. MSProvider
+-[E webSsphere Namlngcmttj

=21 websphere Node

&[4 bedmnode

= bénodea
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*-[53 WebSphere Eventli
# [ WebSphere.J2CRe: Cell
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#-[B WebSphere. IMSPrc / \
= [B WebSphere MaiPro

[ WebSphere.Naming
% [E WebSphere.Object W W
4 WebSphere Schedy

= [ WebSphere Server

= [ besrOla hﬁtl;l:l)r(l!:‘i‘de bfL\lionalga bﬁr:llgg:b —I
#1-F8 WiahSrhera ET \
4 (3
) -]
{# Diagrams 2 | Outine | ~ B :
=6 @l WabSphors. SR
[ [WﬁbSphare} defatit-b&celb6dmnode (| : e =
s T 1 wl
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ISA VCE “Headless Installation” ’1

Click on File > Preferences - VCE - Utilities > “Deploy” to create
VCEHeadlessRuntime V1.0...zip file

8 1oale - IBM Support Assistant Workbench

e SBdmrisraton  Update Window  Heb

Support Assistant Ehpreferences &| _ ol x|
Bl [rre fiter text Utilities L
@ || § Tods | Coectl gir;:fcf Crephony Ltittes regenenad by Visual Configuraton Explorer
st Marager
Case/Inckdent % ol Search sstrahon drectory: | Co\Temp Browse...
faefaic Guaded Troublesheoter Dephoyabie tites:
1 1M Monitoring and Diagriostic Too? ~
Tools Catalog # IBM Manitonng and Duagrashc Took f —
Media Yiewer
Tool Mame & Mok Validation
Datsbase Cornect Metwork Connechons
M MOMmanmg A Remote Agent Instal
IEM Moriorg are Sinve] Criocleritiaks
M Mororng ary | Lipdater Prefierences
16 Moriar i Ussge Gatherng Featre
1M Pattr Inm':*c WesLal Configuration Explorer
= — Archeve Hander Ay o
JMPortam Capablites G [CEHeadesRLNTMeE_V1.0, 16, 2009090 20632 20
16 Thvisad and My Compre Filrs Preforences
1BM Trace ard Rt Logang Fre - Flease refer 1o Ci\TempvCBHeadessR untimeR.cadme bt for more
] Preferenes Ltk
Log anayzer Froperties Flters LLEITE
Memory Cump D ¥ Rukes Preforenoes
hemory Dump D Topokongy Chagrams =
Symptom Editor Topclogy Service —
Threadanatyzer (T \T:vdwv Templates
Wizl Configuratio Wk
orkspace
al | ] Restore Defalts | apply

Transfer zip file to your USS working directory, and unzip to ./vce dir.
jar —xvf VCEHeadlessRuntime_V1.0.15.20090624.0925.zip

Run the exporter from ./vce/ directory after setting WAS_HOME:
Java jar startup.jar -buildfile wasexporter/wasexport.xml -Dwas.root=$WAS_HOME

FTP the wasexport.xml configuration file to your workstation and re-name it.
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. Y
il Configurationss 22| [1%/ % % = & 9 @ = O VCE QUICk Start s HA RE

Welcome to Visual Configuration =

Explorer! i Cl’eate Workspace

- Quick start « Add Configuration(s) Add Configuration & tool

You can start fresh with a new workspace or open
an existing one to continue a previols session.

+ Create a new workspace from the File/visual L4 C reate N eW D i ag ram NE'I.I'I.I' Dlagra M @ t':":'l

Configuration Explorer Mew Warkspace' dialog.

* Open an existing workspace from the FileAvisual

Configuration Explorer /Open Workspace' dialog. o D rag 0 bj e Cts to d i ag ram

+ Import a configuiration into & new or existing b
workspace from the File/visuial Configuration

Explorer/Import configuration’ dialog. [ ) S h OW P are n tS O r
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Comparing Object Properties
H H i H ” =] 2
* Right-Click on “Show Properties Node” = Show Properties Node
- " I - ” <‘.|=.|> .
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Appendix swans

Installing the ISA

Other Diagnostic Tools for WebSphere on z/OS
— MVS Modify (F) commands

Working with Dumps & Traces

— Triggering dumps & Traces

— Extracting system dumps for ISA tools

Testing Tools & Sample Applications

Documentation, Help & Web Resources
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Installing the IBM Support Assistant (ISA) s»a==

 Download & Install ISA
— http://www.ibm.com/software/support/isa/
— See |IEA (IBM Education Assistant) for tutorials:

» http://publib.boulder.ibm.com/infocenter/ieduasst/vlrimO/index.jsp?
topic=/com.ibm.iea.selfassist/selfassist/ISAv41 Task.html

— Install Product Add-ons: (100’s)
* ISA: Update > Find New... > Tools Add-ons

» http://www.ibm.com/support/docview.wss?uid=swg27013279
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Other Diagnostic Tools for WebSphere '

- WebSphere “built-in” tools (See InfoCenter)
— Display server - MVS Modify commands
— Trace Dynamically - MVS Modify (F) commands
— Performance Monitor (PMI) & Viewer

— threadmonitor (WAS V7)
— dumpNameSpace

—wsadmin
— ISC

« Other:
— JinsightLive for IBM System z
http://www.alphaworks.ibm.com/tech/jinsightlive

v WebSphere

Trap

Faeamn Sverrn
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s )
The all-powerful MVS Modify command  sua=e

<server_name>,HELP

TRACEALL - Set overall trace level
TRACEBASIC - Set basic trace components
TRACEDETAIL - Set detailed trace components
TRACESPECIFIC - Set specific trace points
TRACEINIT - Reset to initial trace settings
TRACENONE - Turn off all tracing
JAVACORE - Generate jvm core dump
HEAPDUMP - Generate jvm heap dump
JAVATDUMP - Generate jvm tdump
TRACEJAVA - Set java trace options

Tm

<server_name>,DISPLAY ,HELP
LISTENERS - Display listeners

CONNECTIONS - Display connection information
TRACE - Display information about trace settings
JVMHEAP - Display jvm heap statistics

WORK - Display work elements

ERRLOG - Display the last 10 entries in the error log
THREADS - Display thread status

[ ) ° [ ) ° ° ° ° -I-I
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Working with Dumps i
e Java Dumps > /var/home/... MVS console commands

— Heap: MVS command: F <server_name>,HEAPDUMP

— Core: F <server_name>,JAVACORE

- JVM TDUMP: F <server_name>,JAVATDUMP

Heapdumps (and javacore) written to home dir

(Default = /var/WebSphere/home/cell/<servant Group I1D>

 WebSphere ABEND dumps >/var/home/...
« SYSABEND & CEE Dumps > JES SPOOL

e SVC Dumps, ABEND Dumps > SYS1.DUMP.Dyy
— Setup Dump Options:
CD SET,SDUMP=(RGN)
D DUMP,O
SDUMP- ADD OPTIONS (LSQA,RGN,TRT)
— MVS Dump console command:
Dump COMM=“title”
R nn, Jobname=H7SR0O1AS
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jextract - Convert SVC dump for Dump Analyzer *

SHARE

e jextract is shipped with the IBM JVM in the ../java/bin/ directory
e Point directly to the Dump dataset:

/shared/zWebSphere/V7R0/java64/36.0_64/bin/jextract SYS1.DUMP.D091014.T102814 .SYSB.S00003
Loading dump file...

Read memory image from SYS1.DUMP.D091014.T102814.SYSB.S00003

Set debug scratch space size to 8 MB

VM set to 000000080B178548

Dumping JExtract file to SYS1.DUMP.D091014.T102814.SYSB.S00003.xml

<I-- extracting gpf state --> <I-- 5ms -->

<I-- extracting host network data --> <!-- 9ms -->
<I-- extracting classes --> <!-- 183200ms -->

<!-- extracting monitors --> __<I-- 188234ms -->
<I-- extracting threads --> .<I-- 195727ms -->

<I-- extracting trace buffers --> <I-- 195740ms -->
<I-- extracting roots -->.<I-- 199500ms -->

<I-- extracting objects --> .<I-- 268266ms -->

Finished writing jextract XML file in 268268ms

Warning: found 14 inconsistencies in the dump file. Further information has been written to the
jextract XML File

Creating archive file: SYS1.DUMP.D091014.T102814.SYSB.S00003.zip
Adding ""SYS1.DUMP.D091014.T102814.SYSB.S00003""

Adding ""SYS1.DUMP.D091014.T102814.SYSB.S00003.xml*"

Adding "'/shared/zWebSphere/V7R0/java64/36.0_64/1ib/TraceFormat.dat"
Adding "/shared/zWebSphere/V7R0/java64/J36.0_64/1ib/J9TraceFormat.dat"
jextract complete..

* FTP the resulting .zip file to your workstation.

» May have to specify these arguments:
export J9DBGEXT_SCRATCH_SI1ZE=8
Jjextract -J-DJavaio.tmpdir=/u/hutch/largezfs-Xmx1024 SYS1.DUMP.D091014.

Jdmpview - Replaced by the ISA Dump Analyzer or Memory Analyzer?
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Testing Tools

e Load Drivers
— JMeter
— Microsoft ™ Web Application Stress Tool
— LoadRunner, Silk, ...

o Sample Applications

— Techdoc WP101612 “Getting started with analysis of GC,
Heapdumps and Javacores For WebSphere on z/OS”
* PD Application Tools: causeOutOfMemory, Sleeper
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ISA Built-in Documentation (local eclipse): sw#a=-

Welcome to IBM Support Assistant

Find Information “Find |nf0rmatI0n" = SearCh

Easily find the information you
need including product specific
intormation and search
capabilitiez

Support Assistant

" Find Information x

~ Search Targets & Search Information &5 Media Viewer| 1 Product Information

W
& [ B software Support Cocuments IEM SUpport Assistant Search

4 [¥] BM developeryworks

Search: |ZI'OS "Process Server" j Go! | Advanced Search

[Z] [¥] 1BM Mewsgroups and Forums

Google ”
» Search Targets WebsSphere Process Server 6.1 > WebSphere Process Serve
o Product Information Centers ~ Search Results

57 stop Searching
| BM Software Support Documents (50 of 1523 resulf

7/27/2010 SHARE 11! E IBM developerworks Uninstaling WebSphere Process Server for 2/0S
Information Management (45 of 45 results)




ISA Help
http://localhost:1260/help/index.isp

- nghllght a t00| E‘!IBI\"ISupportAssistant Workbench
Search: 5] search scope: All topics
(e.g., HeapAnalyzer) Contents elo & 0o
CI k h “H I ” b ﬁlntroduction to IBM Support Assistant V4.1 Tool: [Tech Preview] HeapAnz
—_ " =% IBM Si rt Assistant Migrati
Ick on the "Help” tab: 2@ Cotomamg ths ok IBM® Hea

© Network Connections
Usage Gathering Feature
Administering the Agents

Tools Catalog

Customizing the Agent
Using the Data Collector IBM Heapli
Tool Mame Using Tools Creator/Archite
) - Using the Media Viewer A
[Tech Preview] Database Connection Pool Analyzer for IBM |5 ¢ yging the Case Manager Jinwoo E

zar =€ Using the Guided Troubleshooter jinwoo(@us.i
=% Using the Systems Explorer

@ Securing the IBM Support Assistant
Submitting a Service Request

attern Modeling and Analysis Tool for

Welcome to IBM HeapAnalyze

MTAmb D s TORA Mmard O omieimieem Tomomd - z
Troubleshooting and Support allows the finding of a possible

‘ Laurich | Submit Feedback | ‘ N Help | Reference through its heuristic search engi
N\ How to use Help heap dump in Java applications.

Log Analyzer information at

@ Tool: [Tech Preview] Database Connection Po|| http://www.alphaworks.ibm.co1
# € Tool: [Tech Preview] HeapAnalyzer
¢ Tool: [Tech Preview] IBM Pattern Modeling an .
=€ Tool: [Tech Preview] IBM Thread and Monitor IntrOdUCthD
¢ Tool: [Tech Preview] IBM Trace and Request
Tool: [Tech Preview] IBM Web Server Plug-in || The Heapdump contains a list o1
Tool: [Tech Preview] Memory Dump Diagnosti| . heap.

Tool: IBM Monitoring and Diagnostic Tools for
Tool: IBM Monitoring and Diagnostic Tools for
Tool: IBM Monitoring and Diagnostic Tools for
Tool: IBM Monitoring and Diagnostic Tools for
=€ Tool: IBM Port Scanning Tool (Tech Preview)

Heapdumps can be very large w

them.

© Tool: Memory Dump Diagnostic for Java It's not always easy to analyze a
#¢ Tool: Visual Configuration Explorer analyzes heapdumps of Java SD
‘| | »

B | & [ % [ = !
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ISA Resources
ISA website:

www.ibm.com/support/docview.wss?rs=3455&uid=swg27012682
www.ibm.com/support/docview.wss?rs=3455&context=SSLLVC&qgl=vce&uid=swqg27013116

ISA Download website www.ibm.com/software/support/isa/download.html
ISA V4.1.1 ReadMe www.ibm.com/support/docview.wss?uid=swg27016886
IBM Support Assistant Team www.ibm.com/software/support/isa

ISA Forum www.ibm.com/developerworks/forums/forum.jspa?forumlD=935
Comments/feedback to: IBMSA@us.ibm.com
IBM Education Assistant (IEA) tutorials:

publib.boulder.ibm.com/infocenter/ieduasst/vlrimO/index.jsp?topic=/com.ibm.iea.selfassist
[selfassist/ISAv41l Task.html

IBM Diagnostics Guides www.ibm.com/developerworks/java/jdk/diagnosis/index.html
IBM Techdocs at www.ibm.com/support/techdocs: wp101575 & WP101612
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